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Introduction
This guide provides information necessary to deploy Siebel eCollaboration as a 
feature in your Siebel eBusiness Applications environment.

This book will be useful primarily to people whose title or job description matches 
one of the following:

Technical users of this guide should possess skills in application development or 
server configuration. Expertise in collaborative communications systems would be 
a useful asset.

Call Center 
Administrators

Persons responsible for setting up and maintaining a call center. 
Duties include designing and managing elements such as 
communications integration, SmartScripts, and message 
broadcasts.

Communications 
Administrators

Persons responsible for setting up and maintaining 
communications integrations such as those supported by Siebel 
Communications Server, including creating communications 
configurations and communications profiles.

Siebel Application 
Administrators

Persons responsible for planning, setting up, and maintaining 
Siebel applications.

Siebel Application 
Developers 

Persons who plan, implement, and configure Siebel applications.

Siebel System 
Administrators

Persons responsible for the whole system, including installing, 
maintaining, and upgrading Siebel applications. 

Database 
Administrators

Persons who administer the database system, including data 
loading; system monitoring, backup, and recovery; space 
allocation and sizing; and user account management.
Version 7.5, Rev. A Siebel eCollaboration Administration Guide 7



Introduction

How This Guide Is Organized
How This Guide Is Organized
This guide includes sections that provide:

■ Understanding of Siebel eCollaboration components and processes. These sections 
include background on the end users’ experiences, server architecture and 
processes, and client components.

■ Instructions for setting up Siebel eCollaboration architectural components. These 
sections include material on installing and configuring the eCollaboration server, 
integrating eCollaboration into a communications configuration.

■ Configuring and Administering Siebel eCollaboration. These sections include 
instructions about configuring eCollaboration and about administering server 
parameters and Web collaboration templates, allowing agents to accept Web 
calls, and tracking session data.
8 Siebel eCollaboration Administration Guide Version 7.5, Rev. A



Introduction

Revision History
Revision History
Siebel eCollaboration Administration Guide

Version 7.5, Rev. A
Table 1. Changes Made in Version 7.5, Rev A

Topic Revision

“Updating the JRun Classpath” on page 49 Added this section. 

Chapter 3, “Siebel eCollaboration Server 
Load Balancing”

Added this chapter. 
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Siebel eCollaboration Architecture 1
This chapter provides conceptual and procedural information about the caller and 
agent experiences using Siebel eCollaboration and about the architecture and 
processes that are active during a collaboration session.

This chapter covers the following topics: 

■ “About Siebel eCollaboration” on page 12

■ “Siebel eCollaboration End User Overview” on page 13

■ “Siebel eCollaboration Architecture Overview” on page 34

■ “Siebel eCollaboration Client Overview” on page 38
Version 7.5, Rev. A Siebel eCollaboration Administration Guide 11
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About Siebel eCollaboration
About Siebel eCollaboration
Siebel eCollaboration allows customer care agents and callers to “meet on the Web” 
and use a variety of visual and verbal communication tools. They see the same 
desktop image, as if they were sitting at the same computer.

When a caller requests a Web collaboration session by clicking Contact Us on most 
Siebel customer applications, a session is created automatically. When an agent 
accepts the caller’s Web call, the agent and the caller both see the last page the 
caller was on prior to clicking Contact Us. The agent and caller are also connected 
by the caller’s choice of verbal interaction—voice over IP, phone, or Web chat.

With Follow-me browsing, the agent and caller virtually share a browser. When 
either one navigates to another page, the other’s browser also displays the new 
page. The agent and caller can also use this functionality to jointly complete a Web 
form.

In addition to touring different Web pages, the agent and caller can display 
applications to each other. Either participant can display the entire desktop to the 
other, even if the other does not have the application being displayed.

Because the agent can see what the caller sees, the agent is better equipped to guide 
the caller to Web pages to find information, perform demonstrations, or to help the 
caller complete a task. The caller is better equipped to convey the service issue and 
to understand the solution that the agent communicates.

NOTE: Because of the nature of eCollaboration, some types of advanced browser 
capabilities are not available. Advanced client-side browser technologies do not 
make use of typical server connectivity. Some Siebel products, including but not 
limited to Siebel eAdvisor and Siebel applications in high interactivity state, make 
extensive use of client-side Java scripting. Because these Javascripts are executed 
in the client (the browser), the server never receives the commands and cannot pass 
these commands between browsers.
12 Siebel eCollaboration Administration Guide Version 7.5, Rev. A
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Siebel eCollaboration End User Overview
Siebel eCollaboration End User Overview
A caller seeking service can request and participate in a Siebel eCollaboration 
session. An agent can accept an eCollaboration session request and controls the 
means of interaction during the session. 

Typically, the agent and the caller are using one of two principal modes at any given 
time: Follow-me browsing or Present/Attend mode.

In Follow-me browsing mode, when either the agent or the caller navigates to any 
Web page, the other’s browser goes to the same Web page automatically. 

In Present and Attend modes, either the agent or the caller presents desktop 
imagery while the other views passively. 

Both the caller and the agent can use the following features, but the agent controls 
when several of these features are available to the caller.

■ Use Follow-me browsing

■ Pause Follow-me browsing so that either participant can go to any Web page 
without the other browser following

■ Use Present and Attend modes

■ Use dynamic joint Web form filling

■ Converse using Web chat

■ Converse using voice over IP

■ Pause transmission of desktop imagery

■ Go back to the last Web page visited

■ Go forward to the Web page from which the Back button was last used

■ Refresh the current Web page

■ Go to the last Siebel application Web page visited 

■ End the session

Only the caller can take the following actions:
Version 7.5, Rev. A Siebel eCollaboration Administration Guide 13
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Siebel eCollaboration End User Overview
■ Request a session

■ Request the communication mode for the session

■ Cancel a requested session

Only the agent can take the following actions:

■ Accept a session

■ Transfer a session to another agent

■ While the agent is in Attend mode, end a caller’s transmission of desktop 
imagery

NOTE: Functionality that is available with Siebel eCollaboration may not be available 
with other Web collaboration technologies you integrate with Siebel applications.

For information about browsers supported by Siebel eCollaboration, see Siebel 
System Requirements and Supported Platforms.
14 Siebel eCollaboration Administration Guide Version 7.5, Rev. A
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The eCollaboration Toolbar
The eCollaboration Toolbar
The Siebel eCollaboration toolbar resides in the agent’s eCollaboration cobrowser 
and in the caller’s cobrowser. eCollaboration allows the agent to control the session, 
so the agent’s toolbar provides more options. 

Figure 1 shows the main panel of buttons in the agent’s eCollaboration toolbar. The 
caller has the subset of buttons to the left of the divider line. The End Session button 
is on the right end of the agent’s and the caller’s toolbar, separated from the main 
panel.

The following eCollaboration toolbar buttons are provided to the agent and to the 
caller:

■ Back. Go to the last Web page visited.

■ Forward. Go to the Web page from which the Back button was last clicked.

■ Pause. Suspend page-pushing to the other party. Click again to resume.

■ Refresh. Update the current Web page.

■ End Session. End the eCollaboration session.

The following eCollaboration toolbar buttons are provided only to the agent:

■ Download. Download Present mode plug-in to the caller. The download plug-in 
checks both on the caller’s and the agent’s machines for an existing installation 
of eCollaboration client software. If a previous installation is not found, then the 
caller, the agent, or both are prompted to confirm acceptance of the download.

Figure 1. Siebel eCollaboration Toolbar

Back DownloadPause Voice over IPAttend

Forward Refresh Present Show Pointer
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The eCollaboration Toolbar
■ Present. Assume Present mode. The agent and the caller view the agent’s 
desktop imagery only. A capture frame controlled by the agent determines what 
imagery is viewed. Click again to end Present mode.

■ Attend. Assume Attend mode, so that the caller can present. The agent regains 
Present mode by clicking the attend button again.

■ Show Pointer. The cursor on the current presenter’s desktop appears. Click again 
to end cursor display.

■ Voice over IP. Invoke Voice over IP mode so both participants can communicate 
through the computers’ microphones and speakers. This icon appears only if the 
caller requests a voice over IP session.
16 Siebel eCollaboration Administration Guide Version 7.5, Rev. A
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The Caller’s Experience of eCollaboration
The Caller’s Experience of eCollaboration
We will look at the following features of the caller’s experience of eCollaboration

■ “Requesting a Virtual Meeting with eCollaboration” on page 17

■ “Requesting an eCollaboration Session” on page 18

■ “Follow-Me Browsing in Siebel eCollaboration” on page 19

■ “Dynamic Joint Web Form Filling in Siebel eCollaboration” on page 20

■ “Present and Attend Modes in Siebel eCollaboration” on page 21

■ “Chatting in Siebel eCollaboration” on page 22

■ “Using Voice over IP in Siebel eCollaboration” on page 22

■ “Ending an eCollaboration Session” on page 23

Requesting a Virtual Meeting with eCollaboration
A Web site visitor can request a real time virtual meeting with an agent by clicking 
Contact Us, a button that is present on many Siebel customer application Web 
pages.

Besides the Java applets that are downloaded for each session, Siebel 
eCollaboration requires browser plug-ins to be on the caller’s computer if the caller 
requests voice over IP or the collaboration includes a presentation session. The 
caller is offered a download of these plug-ins if they are not detected when the caller 
requests an collaboration session. 

After one download, the caller does not typically have to download these plug-ins 
for subsequent sessions. However, if you upgrade your eCollaboration server, a 
newer version of these utilities may become standard, and a caller who has the 
previous version may need to download the new software. Siebel eCollaboration 
detects the version of client software and downloads new software when 
appropriate.
Version 7.5, Rev. A Siebel eCollaboration Administration Guide 17
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Requesting an eCollaboration Session
When a caller requests an eCollaboration session with an agent, the caller chooses 
a verbal communication mode and can choose to share desktop imagery with the 
agent.

To request an eCollaboration session

1 The caller clicks Contact Us, present on most Siebel customer application Web 
pages.

The Contact Us page appears, with hyperlinks for invoking available 
communication channels.

2 The caller clicks the Contact a customer care representative hyperlink.

The Live Web Assistance form appears. If the caller is a registered user, the 
telephone number populates the appropriate field automatically. 

3 The caller completes the form, describing the service issue, editing the telephone 
number if necessary, and choosing one of the following session options:

■ Chat & Collaboration. The session uses eCollaboration technology for Follow-
me browsing and sharing desktop imagery. The caller and the agent converse 
by using Web chat.

■ Chat Only. The caller and the agent converse using Web chat only. A 
cobrowser is provided for the chat.

■ Call Back. The agent contacts the caller at the telephone number specified in 
the request.

■ Call Back & Collaboration. The session uses eCollaboration technology for 
Follow-me browsing and sharing desktop imagery. The agent contacts the 
caller at the available telephone number specified in the request.

■ Voice Over IP & Collaboration. The session uses eCollaboration technology for 
Follow-me browsing and sharing desktop imagery. The caller and the agent 
converse over the same connection using voice over IP technology.

For a session to use voice over IP, the caller and the agent must both have a 
microphone and speakers installed on their computers. 

■ If the caller does not have a microphone or speakers, the caller can initiate a 
voice over IP session, but cannot use the mode properly. 
18 Siebel eCollaboration Administration Guide Version 7.5, Rev. A
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■ If the caller chooses voice over IP and the caller’s browser does not have the 
necessary plug-ins required for voice over IP, the voice over IP software is offered 
to the caller to download. A small pop-up browser appears with the message 
“Please wait. Downloading in progress.” When the download is complete, the 
message changes to “If you close this window, your request and meeting will be 
cancelled.” The caller must allow a short interval for the agent to join the 
session.

Follow-Me Browsing in Siebel eCollaboration
Follow-me browsing is the default mode when a Web collaboration session starts. 
When either the agent or the caller goes to a Web page in the eCollaboration 
cobrowser, the other sees the same Web page. Figure 2 shows the caller’s cobrowser 
window.

The caller can pause Follow-me browsing mode by clicking the pause button on the 
eCollaboration tool bar. The button changes to its resume state. The caller can then 
navigate to any Web page without the agent’s browser following. When the caller 
clicks the resume button, the agent’s browser goes to the caller’s current Web page.

Figure 2. Caller’s eCollaboration Cobrowser Window
Version 7.5, Rev. A Siebel eCollaboration Administration Guide 19
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Dynamic Joint Web Form Filling in Siebel eCollaboration
An agent and a caller can fill out a form on a Web page together. When Follow-me 
browsing is active, both participants can type entries into text fields, toggle check 
boxes or radio buttons, or select from picklists.

Changes appear, as they are made, in both participants’ cobrowsers. The person 
who types first sees the changes immediately. The other person sees the changes 
after a slight delay.

Either participant can further edit the form.

The agent and the caller must be aware of the following principles when using joint 
Web form filling:

■ If both participants fill out the same field at the same time, both participants’ 
keystrokes are captured, resulting in jumbled text.

■ You cannot use joint Web form filling on attachment fields. Attachment fields 
are read only and cannot be surveyed by the Java applet that controls form 
filling. 

■ When a caller or an agent adds an attachment through a cobrowser, only the 
person who adds the attachment can see that the attachment is added. The form 
to which the attachment is added can be successfully submitted only by the 
person who adds the attachment to the form. An error results if the other 
participant tries to submit the form. If there is an error, the person who added 
the attachment must navigate to the appropriate view without using the Back 
button, reattach the file, and resubmit the form.

■ Any field that is controlled by client-side Java scripting cannot be populated by 
joint form filling. For example, you cannot form fill the fields that are associated 
with the calendar pop-up dialog box or the calculator pop-up dialog box on the 
Register a Product Web page because the calendar and calculator pop-up dialog 
boxes use client-side Java script to fill their fields. When a field is filled using, 
for example, the calculator keys, the fields do not jointly fill in both cobrowsers. 
However, if you fill out the fields manually, the fields will jointly form fill.
20 Siebel eCollaboration Administration Guide Version 7.5, Rev. A
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Present and Attend Modes in Siebel eCollaboration
At the agent’s discretion, either participant can present desktop imagery while the 
other participant observes. The presenter can display desktop applications or any 
other imagery present on the desktop.

When the agent initiates Present mode, an attending window opens on the caller’s 
desktop. The window’s interior is black until the agent presents desktop imagery to 
the caller. When the agent presents, the caller can only see the portion of the 
desktop contained within the agent’s capture frame. 

The caller can end the presentation session by clicking on the close button on the 
window’s title bar. If the agent ends the presentation session, the attending window 
also closes.

If the agent allows the caller to present, the caller sees one or both of the following 
dialog boxes:

■ The caller is offered a download of the Present mode plug-in. This only occurs 
in the following cases: 

■ If the caller has never used Present mode.

■ If the caller’s Present mode plug-in must be updated because the 
eCollaboration server has been updated and requires a newer version of the 
client software. 

■ The Moderator Request Received dialog box allows the caller to click Ok to allow 
the agent to view the caller’s desktop or click Cancel to decline. 

■ If the caller clicks Ok, the dialog box disappears, and the agent can see the 
caller’s entire desktop. 

■ If the caller clicks Cancel, the Moderator Request Received dialog box 
disappears and the agent cannot see the caller's desktop.

CAUTION: If the caller closes the eCollaboration cobrowser, the Web collaboration 
session ends. Instead, the caller should minimize the cobrowser if it is not 
intended to be part of the presentation.
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Chatting in Siebel eCollaboration
The Web Chat frame is available during both chat-only and collaboration session.

At any time during a session, a participant can type a chat message into the Web 
Chat frame, and then click Send or press Enter to send it to the other participant.

Using Voice over IP in Siebel eCollaboration
Voice over IP allows the caller to use the microphone and speakers on the computer 
to converse with an agent. 

Voice over IP is invoked in a session only if the caller chooses voice over IP as the 
communication mode when he or she requests the collaboration session.

During an active voice over IP session, the caller can use options associated with 
the audio control button in the task bar’s system tray to change audio settings or 
terminate voice over IP.

NOTE: It is recommended that you do not change the audio settings for low 
bandwidth conditions (128 kbaud or slower). 

To change audio settings during a voice over IP session

1 The caller right-clicks the audio control button in the task bar’s system tray.

The audio control menu appears.

2 The caller does one of the following:

■ To toggle between turning compression of IP packets sending audio data on 
and off, the caller chooses Compression. 

■ To improve the audio quality by changing the sampling frequency, the caller 
chooses Audio Quality and an appropriate frequency.

■ To toggle the microphone on and off, the caller chooses microphone.

The caller can control volume levels for the microphone and the speakers.
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To control volume levels

1 The caller double clicks the audio control button in the task bar’s system tray.

An audio level control appears.

2 The caller can change the sound level for the microphone or the speakers.

The caller can terminate voice over IP during a collaboration session. Follow-me 
browsing and chat remain active.

To terminate voice over IP

■ Right-click the audio control icon and choose Close from the menu.

The agent can turn the microphone and speakers of either participant on or off.

Ending an eCollaboration Session
By ending an eCollaboration session, all collaboration activity ceases, including 
voice over IP.

The caller can end an eCollaboration session in one of the following ways:

■ Click End Session on the eCollaboration toolbar.

■ Close the eCollaboration cobrowser. 

■ In a chat only session, the caller must use the close window control on the 
window’s title bar to end the session.
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The Agent’s Experience of eCollaboration
Siebel eCollaboration uses Siebel Universal Queuing to route Web calls and other 
caller-initiated communication to agents. Siebel eCollaboration uses the 
communications toolbar to notify agents of waiting Web calls and other requests. 

NOTE: If you implement another Web collaboration technology, it may or may not 
use Siebel Universal Queuing or the communications toolbar to notify agents of 
Web calls. For information about the means by which agents accept Web calls, you 
must consult the documentation of the vendor that provides the queuing 
functionality.

Before a Web call can be routed to an agent, the agent must be defined to the 
Communications Server as eligible to receive Web calls.

An agent must click the login button on the communications toolbar to log in to 
Universal Queuing. On each login, the application determines whether the agent’s 
machine has the eCollaboration software for voice over IP and Present mode. If the 
software is not detected, the agent is prompted to download the software. A 
download prompt is not displayed if the agent has the software. If the agent is not 
a Web agent as defined in the Universal Queuing administrative screens, the 
download is not offered to the agent. 

NOTE: When the agent clicks the download button during a collaboration session, 
the Present mode software is downloaded to the agent’s desktop, if it is not already 
present, and to the caller's desktop at the same time.

For more information about making it possible for an agent to receive Web calls, see 
“Setting Up Agents to Receive Web Calls” on page 63.

For information about administering Siebel Universal Queuing, see Siebel Universal 
Queuing Administration Guide.
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Accepting an eCollaboration Session Request
An agent accepts a Web call request from a caller by clicking the accept work item 
button on the communications toolbar.

NOTE: When a caller requests a call-back, the activity type listed in the Web 
Collaboration Activity form informs the agent that this is a required call-back.

To accept an eCollaboration session request

1 When the accept work item button on the communications toolbar blinks, an 
agent accepts an incoming Web collaboration request in one of the following 
ways:

■ The agent clicks the accept work item button.

■ The agent clicks the right arrow button to the right of the accept work item 
button to see the media type for one or more waiting communications, and 
then clicks the accept incoming Web call button if it is active.

■ The agent uses a hot key that is defined for accepting work items. 

For information about implementing hot keys, see Siebel Communications 
Server Administration Guide.

The Web Collaboration Activity form appears, showing contact identification 
information, a history of the contact’s activities, and the data the caller entered 
in the Live Web Assistance form. The eCollaboration cobrowser also appears in 
a separate window.

2 The agent does one of the following:

■ If the caller requests to speak by telephone, the agent places a telephone call 
to the caller manually or by clicking the make call button on the 
communications toolbar. If the line is busy, the agent initiates 
communication by typing a chat message, and then clicks Send or presses 
Enter on the keyboard.

■ If the caller requests to speak by voice over IP, the agent clicks the voice over 
IP button (telephone icon) on the eCollaboration toolbar to initiate voice over 
IP and uses the microphone to greet the caller.
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■ If the caller requests to chat, the agent greets the caller by typing a chat 
message, and then clicks Send or hit the Enter key on the keyboard.

Follow-Me Browsing in Siebel eCollaboration
Follow-me browsing is the default mode when an eCollaboration session starts. 
When either the agent or the caller goes to a Web page in the eCollaboration 
cobrowser, the other sees the same Web page. 

The agent can pause Follow-me browsing mode by clicking the pause button on the 
eCollaboration tool bar. The button changes to its resume state. The agent can then 
navigate to any Web page without the caller’s browser following. When the agent 
clicks the resume button, the caller’s browser goes to the agent’s current Web page.

The following must be true for Follow-me browsing to be active:

■ The cobrowser is not minimized.

■ Neither the Present mode nor the Attend mode is active.

Dynamic Joint Web Form Filling in Siebel eCollaboration
An agent and a caller can fill out a form on a Web page together. When Follow-me 
browsing is active, both participants can make entries to the same form.

Changes appear, as they are made, in both participants’ cobrowsers. The person 
who types first sees the changes immediately. The other person sees the changes 
after a slight delay.

Either participant can further edit the form.

The agent and the caller must be aware of the following principles when using joint 
Web form filling:

■ If both participants fill out the same field at the same time, both participants’ 
keystrokes are captured, resulting in jumbled text.

■ You cannot use joint Web form filling on attachment fields. Attachment fields 
are read only and cannot be surveyed by the Java applet that controls form 
filling. 
26 Siebel eCollaboration Administration Guide Version 7.5, Rev. A



Siebel eCollaboration Architecture

The Agent’s Experience of eCollaboration
■ When a caller or an agent adds an attachment through a cobrowser, only the 
person who adds the attachment can see that the attachment is added. The form 
to which the attachment is added can be successfully submitted only by the 
person who adds the attachment to the form. An error results if the other 
participant tries to submit the form. If there is an error, the person who added 
the attachment must navigate to the appropriate view without using the Back 
button, reattach the file, and resubmit the form.

■ Any field that is controlled by client-side Java scripting cannot be populated by 
joint form filling. For example, you cannot form fill the fields that are associated 
with the calendar pop-up dialog box or the calculator pop-up dialog box on the 
Register a Product Web page because the calendar and calculator pop-up dialog 
boxes use client-side Java script to fill their fields. When a field is filled using, 
for example, the calculator keys, the fields do not jointly fill in both cobrowsers. 
However, if you fill out the fields manually, the fields will jointly form fill.

Present and Attend Modes in Siebel eCollaboration
At the agent’s discretion, either participant can present desktop imagery while the 
other participant observes. The presenter can display desktop applications or any 
other imagery present on the desktop.

When an agent presents, the agent controls what is seen by sizing and moving a 
capture frame. When the caller presents, the caller’s entire desktop is displayed.

CAUTION: If the agent closes the eCollaboration cobrowser, the Web collaboration 
session ends. Instead, the agent should minimize the cobrowser if it is not intended 
as part of the presentation.

In either Present or Attend mode, the agent can turn on the mouse pointer by 
selecting the mouse pointer button. The button changes color to represent that the 
pointer is turned on, and the agent and the caller see the location of the mouse. In 
Present mode, the mouse does not track while the capture frame is paused or when 
the mouse cursor is not within the capture frame. 

To use Present and Attend modes

1 The agent minimizes or closes all windows on the desktop that are not intended 
for caller viewing.
Version 7.5, Rev. A Siebel eCollaboration Administration Guide 27



Siebel eCollaboration Architecture

The Agent’s Experience of eCollaboration
2 The agent clicks the present button (clapboard icon) in the eCollaboration 
toolbar.

A red capture frame appears, indicating that data is not being presented. The 
agent can resize the capture frame to contain the information that the agent 
wants to display to the caller.

3 The agent clicks the play button on the capture frame to toggle from the paused 
state to an active state. 

The play button changes to a pause button. The capture frame turns green or, 
depending on network traffic, yellow first, and then green. Green indicates that 
all the information in the capture frame has been sent to the caller. Yellow 
indicates that transmission of some material is not complete. The agent does not 
see the caller’s desktop. 

NOTE: The agent can pause the capture frame at any time by clicking the pause 
button.

4 The agent moves or resizes the capture frame as appropriate. 

5 If the agent allows the caller to present, then the agent must take the following 
actions:

a The agent must make sure that the caller has the Present mode software by 
verifying verbally with the caller or by clicking the download button (dotted 
down arrow to CPU icon) in the eCollaboration toolbar to download the 
software to the caller.

If the agent clicks the download button and the caller does not have the 
Present mode browser plug-in, a dialog box is displayed to the caller offering 
to download the plug-in. 
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b The agent clicks the attend button (monitor icon).

An attending window opens on the agent's desktop. A dialog box warns the 
caller that his or her entire desktop will be visible to the agent, with an option 
to Cancel. If the caller clicks Cancel, the agent receives a message stating that 
the caller is declining to present the desktop, and the attending window 
closes.

The agent should maximize the cobrowser so that the caller’s desktop 
imagery can be seen.

6 To reclaim Present mode from the caller, the agent clicks the attend button to 
stop Attend mode, and then clicks the present button. While in Present or Attend 
mode, the other button (attend or present) is inactive.

7 To exit Present or Attend mode without ending the session, the agent clicks 
whichever button is active, present or attend, so that both are inactive. 
Alternatively, the agent can close the Present/Attend mode cobrowser window. 

Follow-me browsing resumes.

Changing the Mouse Pointer Icon
The mouse pointer icon used optionally in Present mode is the present.bmp file in 
the /Program files/eCollaboration client install directory/icons 
directory on the client machine. Typically, the client install directory name is 
eCollaboration.

To display a different mouse pointer, modify the current present.bmp graphic or 
create a new present.bmp, and then replace the file in the \icons directory.

Transferring an eCollaboration Session to Another Agent
There are two kinds of collaboration session transfers:

■ Blind transfer. An agent transfers a collaboration session without first conferring 
with the receiving agent.

■ Consultative transfer. An agent transfers a collaboration session after first 
conferring with the receiving agent.
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When an agent receives a transferred call, it is in Follow-me browsing, whether the 
session was in Present, Attend, or Follow-me browsing mode when it was 
transferred. The receiving agent determines the verbal communication mode for the 
session from the activity type field. 

If a transferred session is using Web chat, a separate attachment to the session’s 
activity record is created for each agent’s segment of the chat.

To perform a blind transfer of a collaboration session

1 (Optional) The agent enters into the text input field on the communications 
toolbar the contact information, such as the phone extension, of the person to 
whom the agent wants to transfer the collaboration session.

2 The agent clicks Blind Transfer on the communications toolbar.

3 If the agent did not specify contact information first, the agent does so now in 
the pop-up window that appears.

The session is released immediately.

A consultative transfer is performed differently, depending on the mode of verbal 
communication.

To perform a consultative transfer of a collaboration session using telephone 
communication

1 (Optional) The agent enters into the text input field on the communications 
toolbar the extension of the person to whom the agent wants to transfer the 
active phone call.

2 The agent clicks Consultative Transfer on the communications toolbar.

3 If the agent did not specify the extension first, the agent does so now in the pop-
up window that appears.

The current session is suspended, and the transfer recipient is dialed.

4 The agent does one of the following:

■ When the transfer recipient answers and indicates acceptance of the transfer, 
the transferring agent clicks Consultative Transfer again to complete the 
transfer and release the session.
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■ If the transfer recipient does not accept the transfer, the agent clicks Retrieve 
Call to retrieve the session. 

To perform a consultative transfer of a collaboration session using chat or voice 
over IP

1 The agent places a telephone call independently to the person to whom the 
agent wants to transfer the session to get acceptance for the session, and then 
ends the consultative call.

2 (Optional) The agent enters into the text input field on the communications 
toolbar the contact information, such as the phone extension, of the receiving 
agent.

3 The agent clicks Blind Transfer on the communications toolbar.

4 If the agent did not specify contact information first, the agent does so now in 
the pop-up window that appears.

The session is released immediately.

Chatting in Siebel eCollaboration
The Web Chat frame at the bottom of the cobrowser is persistent during a 
collaboration session. Chat mode is always available.

At any time during a session, a participant can type a chat message into the Web 
Chat frame, and then click Send or press Enter to send it to the other participant. 

Using Voice Over IP in Siebel eCollaboration
The voice over IP button appears only if the caller requests voice over IP during the 
initial request for a collaborative session. An agent clicks the voice over IP button 
on the eCollaboration toolbar to activate voice over IP at any time during the 
session. The button toggles to turn voice over IP on or off. 

When the agent turns on voice over IP, the agent’s microphone and speakers are 
activated to allow communication with the caller. When they are turned off, nothing 
is transmitted between the caller and the agent using Voice over IP mode.
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During an active voice over IP session, the agent can use options associated with 
the audio control button in the task bar’s system tray to change audio settings or 
terminate voice over IP.

NOTE: It is recommended that you do not change the audio settings for low 
bandwidth conditions (128 kbaud or slower). 

To change audio settings during a voice over IP session

1 The agent right-clicks the audio control button in the task bar’s system tray.

The audio control menu appears.

2 The agent does one of the following:

■ To toggle between turning compression of IP packets sending audio data on 
and off, the agent chooses Compression. 

■ To improve the audio quality by changing the sampling frequency, the agent 
chooses Audio Quality and an appropriate frequency.

■ To toggle the microphone on and off, the agent chooses microphone.

The agent can control volume levels for the microphone and the speakers.

To control volume levels

1 The agent double clicks the audio control button in the task bar’s system tray.

An audio level control appears.

2 The agent can change the sound level for the microphone or the speakers.

The agent can terminate voice over IP during a collaboration session. Follow-me 
browsing and chat remain active.

To terminate voice over IP

■ Right-click the audio control icon and choose Close from the menu.

The agent can turn on or off the microphone and speakers of either participant.
32 Siebel eCollaboration Administration Guide Version 7.5, Rev. A



Siebel eCollaboration Architecture

The Agent’s Experience of eCollaboration
Ending an eCollaboration Session
An agent can end a collaboration session in any of three ways:

■ Click End Session on the eCollaboration toolbar.

■ Click the release work item button on the communications toolbar.

■ Close the eCollaboration cobrowser.

At the end of each collaboration session, the chat transcript is saved as a read-only 
attachment to the activity. Whether a session is initiated as a chat or not, chat 
functionality is always active.
Version 7.5, Rev. A Siebel eCollaboration Administration Guide 33



Siebel eCollaboration Architecture

Siebel eCollaboration Architecture Overview
Siebel eCollaboration Architecture Overview
The Siebel eCollaboration server is a software suite that supports real-time 
collaboration between agents and callers. It consists of the following components:

■ Web Manager manages Follow-me browsing interaction between the agent’s and 
the caller’s cobrowsers.

■ Chat Manager manages the chat interface and communication between the 
cobrowsers.

■ Meeting Manager manages the server’s database of virtual meeting attributes 
and routes connection requests from the PictureTalk Meeting application to the 
Communication Session Server that is hosting the meeting.

■ Communication Session Server Manager manages the meetings that are active 
on a particular server.

■ Communication Session Server, a program such as PTKD or PTKHTTPD, is 
launched when a meeting becomes active. It manages all communication, 
transcoding, and compression for a particular meeting.

■ Moderator synchronizes and keeps track of all of the above components.

■ The Web Collab Service business service creates activities, populates views, and 
allows communication among eCollaboration server components.

The Siebel eCollaboration server components work together as follows to create a 
Web collaboration session and to join the caller to the session:

■ The caller, a Web site visitor, logs in to a Siebel customer application through a 
Web browser, and then clicks Contact Us, typically at the top of the Web page. 
On the resulting Contact Us page, the caller clicks the Contact a customer care 
representative link.

■ The caller completes an online form, describing the reason for contacting a 
representative and specifying the preferred verbal mode. 

■ When the caller clicks Submit, the request is routed through the Siebel Web 
Engine to the Siebel Object Manager. The Siebel Object Manager invokes the 
Web Collab Service business service.
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■ The business service creates an activity record for the call and a work item 
to be routed by a queuing engine.

■ The service builds an acknowledgement view that appears to the caller. This 
view contains a JavaScript that opens a new browser on the caller’s machine 
and retrieves initialization JavaScripts from the Siebel database after first 
providing initialization variables for those scripts. 

■ An initialization script checks the type of collaboration requested: voice over IP 
with collaboration, chat, chat with collaboration, call-back, or call-back with 
collaboration. If the caller requests voice over IP, the script calls an HTML page 
that determines whether the caller’s Web browser’s plug-in registry includes the 
voice over IP client. 

■ If the voice over IP client is not listed, the eCollaboration server checks the 
computer’s operating system and downloads the appropriate voice over IP 
client.

■ If the download fails, an error page appears to the caller. The caller must 
install the client before any further steps can occur.

■ The eCollaboration server sends an HTML page in a new browser window that 
contains a Java applet and a message asking the caller to not close the new 
browser window. 

■ The Java applet polls the Web Manager, waiting for an agent to enter the 
meeting. When the agent joins the meeting, the applet launches a cobrowser for 
the caller. The caller is joined to the meeting when the cobrowser is launched. 

After the Web collaboration session is created and the caller has joined the session, 
the Siebel eCollaboration server components work together as follows to join an 
agent to the session:

■ After the agent logs in to a Siebel application, the agent must log in to the 
Universal Queuing server by clicking on the login button on the communications 
toolbar. 

■ When a caller submits a request, the Web Collab Service business service creates 
a new activity record in the Siebel database and a work item. It sends the work 
item to Universal Queuing for routing.
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■ Universal Queuing determines the appropriate agent or agent group, determines 
whether an agent is available to take the Web call, and sends the request to an 
available agent.

■ The accept work button, on the communications toolbar, notifies the agent that 
work item is waiting. 

■ When the agent clicks the accept work button, the Web Collab Service business 
service does the following:

■ It sends an HTTP request to the eCollaboration server to join the agent to the 
session. 

■ It generates a new page to show the request details and appends a JavaScript 
on the page that in turn opens agent-side windows.

During a collaboration session, the Java applets on the caller’s and agent’s 
cobrowsers communicate through the Web Manager. Each page request is sent to 
the Web Manager, which distributes it to the cobrowsers.

The agent can invoke a presentation session at any time during the collaboration 
session.

■ When the agent clicks the present button or attend button on the eCollaboration 
toolbar to start a presentation session, the following events result:

■ The Siebel eCollaboration Web Application passes meeting attributes to the 
Meeting Manager application to create a meeting for the presentation 
session.

NOTE: A meeting for a presentation session is the same as a meeting created 
for a voice over IP session. If the caller requests voice over IP, the meeting is 
created automatically at the beginning of the Web collaboration session, 
instead of being invoked by the agent.

■ The Meeting Manager application creates a temporary file to store the 
information passed from the Web application.

■ The CSS Manager creates the meeting with the meeting attributes stored in 
the temporary file by launching the Communication Session Server, and then 
reports back to the Meeting Manager.
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■ The Meeting Manager returns a .pts file to both the caller’s and the agent’s 
Web browsers. This file launches the Siebel eCollaboration client for the 
presenter and an attending window for the attending participant. 

■ The Communicator then connects to the CSS to log in to the meeting.

■ The CSS Manager monitors the Communication Session Server’s activities. If 
no communication takes place in the meeting for a period specified in the 
CSS Manager’s configuration file, the CSS Manager shuts down the meeting’s 
Communication Session Server to preserve system resources.

The session ends when the agent clicks the end session button on the 
communications toolbar or either participant clicks End Session on the 
eCollaboration cobrowser toolbar. 

■ If the agent ends the session from the communications toolbar, the Web Collab 
Service business service releases the work item and notifies the eCollaboration 
server to end the session. The eCollaboration server sends the chat script to the 
Siebel Web Engine and logs out the Siebel session for the cobrowser. The 
eCollaboration server also closes caller-side windows and adjusts agent-side 
windows.

■ If the session is ended from the eCollaboration cobrowser toolbar, the 
eCollaboration server sends the chat script to Siebel Web Engine, logs out the 
Siebel session for the cobrowser if applicable, and notifies the agent’s Siebel 
application, such as Siebel Call Center, to release the work item. The 
eCollaboration server also closes caller-side windows and adjusts agent-side 
windows. 
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The Siebel eCollaboration client consists of software to support browser 
implementation of Present and Attend modes and voice over IP.

For information about operating systems, browsers, and other platforms supported 
by Siebel eCollaboration, see Siebel System Requirements and Supported Platforms.

Agent Client
When an agent designated as a Web collaboration agent initially logs in on the 
communications toolbar, eCollaboration does a version check that determines 
whether the agent has the client. If the agent does not have the client, a security 
certificate appears offering to download the software required for Present mode and 
for voice over IP. If the agent accepts, the software is downloaded. If the agent 
declines, the offer is repeated on subsequent logins until it is accepted.

For information about modifying the mouse pointer icon used in Present mode, see 
“Changing the Mouse Pointer Icon” on page 29.

Caller Client
A Web site visitor needs only a Java-enabled Web browser to use a Siebel customer 
application such as Siebel eService. After requesting a Web collaboration session 
with an agent, a caller must have additional client software in the following 
situations:

■ To use voice over IP during a session

■ To use Present mode during a session

If the caller chooses voice over IP and the caller’s browser does not have the plug-
in required for voice over IP, the eCollaboration application offers to download the 
voice over IP software.

If the agent allows the caller to present desktop imagery and the caller’s browser 
does not have the necessary plug-ins or Java applets required for Present mode, the 
agent can manually initiate a download of the Present software to the caller’s 
computer. In the same operation, the software is also downloaded to the agent’s 
computer if it is not detected there.
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The primary components of a Siebel eCollaboration implementation are:

■ Siebel eCollaboration server

■ Macromedia (Allaire) JRun, a servlet engine 

■ Web server, including Siebel Web Engine

■ Siebel server, including the object manager used by eCollaboration

These components can reside on multiple machines in any combination that 
adheres to the following requirements:

■ The Siebel eCollaboration server and Siebel Web Engine must reside on different 
machines.

■ The Siebel eCollaboration server and JRun must reside on the same machines.

NOTE: If you use eCollaboration for helping your customers who are outside of your 
firewall, then you must place the eCollaboration server between your external and 
internal firewalls. If you use eCollaboration to help your employees or individuals 
who have access to your intranet, then you can place the eCollaboration server 
inside of your internal firewall.

Siebel eCollaboration is typically administered through a Siebel application such as 
Siebel Call Center or Siebel Service. Web site visitors typically request Web 
collaboration sessions through Siebel customer applications such as Siebel eService.

A typical implementation of Siebel eCollaboration also includes the following 
components:

■ Siebel Communications Server, including the communications toolbar

■ Siebel Universal Queuing for routing Web call requests
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■ CTI middleware, in implementations that use computer telephony

Process of Setting Up Siebel eCollaboration
To set up eCollaboration for use by agents and Web site visitors, you perform the 
following tasks:

1 “Confirming Installation Requirements” on page 41

2 “Installing the Siebel eCollaboration Server and Related Components” on 
page 42

3 “Setting Server Administration Parameters” on page 58

4 “Integrating Web Collaboration into a Communications Configuration” on 
page 60

5 “Setting Up Agents to Receive Web Calls” on page 63
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The following installations and licensing must be completed before installing Siebel 
eCollaboration:

■ Siebel Gateway 

■ Siebel Server

■ Web server, including Siebel Web Engine

■ License for a Siebel employee application, such as Siebel Call Center or Siebel 
Service

■ Siebel CTI license, if agents use CTI

■ License for a Siebel customer application, for example Siebel eService

■ CTI middleware, if telephone functions are managed by the agent’s computer 
and if agents use Siebel CTI

■ Siebel Universal Queuing

Communications Management server component group must be enabled to allow 
communications session management.

For information about Web servers and operating systems supported by Siebel 
eCollaboration, see Siebel System Requirements and Supported Platforms.

For more information about installing Siebel Server components, see Siebel Server 
Installation Guide for your platform.

For information about enabling session management on Siebel Communications 
Server, see the section on enabling session management in Siebel Communications 
Server Administration Guide.
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Installing the Siebel eCollaboration Server and Related 
Components

This section provides instructions for installing the Siebel eCollaboration server and 
related components in the following environment:

■ Siebel eCollaboration server on Windows NT or on Windows 2000

For information about Web servers and other platforms supported by Siebel 
eCollaboration, see Siebel System Requirements and Supported Platforms.

You must perform the following tasks to set up the Siebel eCollaboration server and 
its related components on Windows NT or Windows 2000:

1 “Installing and Configuring Macromedia (Allaire) JRun” on page 42

2 “Installing the Siebel eCollaboration Server” on page 46

3 “Configuring Network Address Translation” on page 50

4 “Providing a License Key to the eCollaboration Server” on page 54

5 “Verifying Successful Installation” on page 55

Installing and Configuring Macromedia (Allaire) JRun
Macromedia (Allaire) JRun is the servlet engine used by eCollaboration. 
eCollaboration supports JRun 3.0.2a.

Before installing the Siebel eCollaboration server, you must install JRun on the same 
computer.

To use JRun, you must perform the following tasks:

■ Uninstall previous versions of JRun if necessary.

■ Download and install the Java Runtime Engine (JRE), which includes the Java 
Developer Kit, if it is not already installed.

■ Install JRun.
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■ Configure JRun through the JRun Management Console.

CAUTION: If you have an earlier version of JRun, you must uninstall it and delete the 
physical directory from your computer. You may need to restart your machine to 
remove the physical directory.

You must download and install Java Developer Kit (JDK) 1.2 or higher before 
installing JRun. One way of doing so is to download Java™ 2 SDK, Standard Edition, 
at http://www.sun.com. The SDK contains JDK.

Installing JRun
You must install JRun on the same machine as the eCollaboration server.

To install JRun 3.0.2a

1 Stop IIS Admin service if it is running.

2 By default, JRun uses port 8000. Determine whether port 8000 is open. If it is 
not, determine an open port for JRun to use.

3 On the Windows Server Ancillary Programs CD-ROM, double-click the 
jr302.exe file in the Thirdpty\allaire\enu\jrun directory.

The JRun installation wizard’s Welcome screen appears.

4 For each of the screens and dialog boxes shown in the following table, make the 
recommended entry, and then click Next to continue.

Screen/Dialog Box Recommended Entry Comment

Welcome No entry.

JRun License 
Agreement

Yes.

JRun Product Serial 
Number

Enter the serial number JR300E1-
5800-6270-1013 from license.txt file 
in the 
Thirdpty\allaire\enu\jrun 
directory on the Windows Server 
Ancillary Programs CD-ROM.
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Configuring JRun
You must use the JRun Management Console to define communication between 
JRun and to your Web server. 

Before configuring JRun, determine the following:

■ The number of a free port with which JRun can connect to the Web server

■ The full path to the scripts directory on the Web server

JRun Installation 
Folder

Change the destination folder to a 
folder at the root level of the server 
machine, for example C:\JRun.

Click Browse, and then 
enter a new folder name 
or navigate to an existing 
folder.

Setup Type Full installation.

Program Folder Accept the default or specify 
another folder.

Setup Status screen is 
displayed during the 
subsequent installation.

Install JRun Services Yes, install JRun services.

Select a Java 
runtime

Select a Java Development Kit 
(JDK) version 1.2 or later.

JVM Advisor No entry. Read the advisory 
material.

JRun Management 
Console

Accept default port 8000 or enter 
the number of an open port.

See Step 2.

JRun Management 
Console

Create and enter an administrative 
password.

Record this password 
and the “admin” user 
name elsewhere for 
safekeeping.

JRun Product 
Information

Enter your contact information 
(optional).

JRun Setup 
Complete

Click the “Start the JRun 
Management Console, I’ll configure 
my Web server later” radio button.

Click Finish instead of 
Next.

Screen/Dialog Box Recommended Entry Comment
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To configure JRun on Windows platforms with the JRun Management Console

1 Make sure the JRun Admin Server is started and your Web server is stopped. To 
confirm or make changes, choose Start > Settings > Control Panel, and then 
double-click Services.

2 If the JRun Management Console login page is not already displayed, choose 
Start > Programs > JRun 3.0 > JRun Management Console. 

The JRun Management Console login page appears in your browser. 

3 Log in with user name = admin and password = the administrative password 
you created in the To install JRun 3.0.2a procedure. If the JRun Quick Start 
Product Tour browser window appears, close it.

The JRun Application Management Console and Server Administrator page 
appears.

4 Click the connector wizard tab.

The Connector Wizard Step 1 frame appears.

5 Make the following entries for Step 1 of the Connector Wizard, and then click 
Next. 

The following dialog box warns you to stop your Web server and the World Wide 
Web Publishing Service. These services should already be stopped, so click OK.

The Connector Wizard Step 2 frame appears.

Field Description

JRun Server Name Choose JRun Default Server.

Web Server Type Enter your Web server type.

Web Server Version Enter the version of your Web server. The picklist is 
dependent on your Web server type.

Web Server Platform Select the platform on which your server runs. The picklist 
is dependent on your Web server type.
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6 Make the following entries for Step 2 of the Connector Wizard, and then click 
Next.

The Connector Wizard Step 3 frame appears.

7 Make the following entries for Step 3 of the Connector Wizard, and then click 
Next.

The Connector Wizard Step 4 frame appears, indicating successful completion.

8 Click Done, and then log out of the JRun Management Console.

Installing the Siebel eCollaboration Server
Installing the Siebel eCollaboration server updates the class path for the WebSurfer 
in JRun. Each time you reinstall JRun, this class path is lost. If you reinstall JRun, 
then you must manually update the class path. 

Field Description

JRun Server IP Address This is the IP address where JRun resides. The default is the 
IP address for the local host. If JRun and the Web server are 
on the same machine, accept the default. If they are on 
different machines, enter the IP address of the JRun server 
machine.

JRun Server Connector 
Port

Enter the number of an open port that the JRun server will 
use to listen for connections from the Web server.

Field Description

PWS Scripts Directory or 
IIS Scripts Directory

Enter the full path to the scripts directory as it was 
configured when the Web server was installed, for example 
C:\inetpub\scripts. 

Install as a Global Filter Check.
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For information about updating the JRun classpath, see “Updating the JRun 
Classpath” on page 49.

NOTE: If you have an existing installation of Pixion’s PictureTalk server or the Siebel 
eCollaboration (Pixion PictureTalk) server, you must uninstall it before you install 
the Siebel eCollaboration server.

CAUTION: The Siebel eCollaboration server and Siebel Web Engine must reside on 
different machines. 

Before starting the eCollaboration server installation, do the following:

■ Determine and record the IP address of the machine on which you installed 
JRun. You are required to enter this IP address during the installation.

■ HTTP Gateway software allows users to access the eCollaboration server 
securely through firewall ports configured for HTTP. Because most firewalls are 
already configured to support HTTP, the HTTP Gateway allows administrators 
to maintain existing firewalls without having to configure special ports for 
eCollaboration traffic. If you implement a firewall, and your Web server software 
supports virtual IPs, you should install the HTTP Gateway to bind to the same 
port on which the Web server listens, typically port 80. To do so, assign two 
different IP addresses to the machine that hosts both JRun and the 
eCollaboration server. Configure the Web server to listen on the port for one IP 
address and configure the HTTP Gateway, through the following procedure, to 
listen on the same port for the other IP address.

To install the eCollaboration server

1 On the Siebel eCollaboration server computer, close all open applications and 
then insert the Windows Server Ancillary Programs CD-ROM. 

2 In Windows NT Explorer, double-click the setup.exe file in the 
\Thirdpty\pixion\enu\ecollaboration folder on the CD-ROM.

The Siebel eCollaboration server installation wizard extracts files and its 
Welcome screen appears.
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3 Follow the prompts in the following table to complete the installation, using the 
indicated guidelines for your entries.

The Ready to install the application dialog box appears, and then the Updating 
system progress dialog box appears.

Field Description

Destination directory Accept the default or specify a different folder.

Select features Accept the default, “Complete.”

Server configuration port settings Accept the default ports or change to other ports 
that are open.

Instance Accept the default or enter a name of your choice 
for the eCollaboration server virtual directory, for 
example eCollab.

HTTP Gateway IP Enter the IP address of the machine that hosts 
JRun. If you implement a firewall and assign two 
IP addresses to the machine, enter the IP address 
for use by the HTTP Gateway. 

HTTP Gateway port This port communicates with the machine that 
hosts the eCollaboration server. If you implement a 
firewall and assign two IP addresses to the 
machine, enter the common port on which the 
Web server and HTTP Gateway listen, typically the 
default port 80. If you do not implement a firewall, 
enter any port that is open.

Web Server IP Enter the IP address for the Web server machine.

Domain Name Enter the domain name for the Web server, for 
example machinename.companyname.com.

Root Alias Enter the name of the virtual directory that points 
to the WebSurfer pages. Typically, accept the 
default value, websurfer.

Require Proxy Host If Web site users access the eCollaboration server 
through a proxy server, then the proxy settings 
must be filled in. Check the checkbox to access 
another dialog box in which to enter the settings. 
Otherwise, leave the checkbox unchecked.
48 Siebel eCollaboration Administration Guide Version 7.5, Rev. A



Setting Up Siebel eCollaboration

Installing the Siebel eCollaboration Server and Related Components
4 In the dialog box indicating successful installation, click Finish.

5 After exiting the Siebel eCollaboration installation wizard, click OK in the Install 
dialog box to restart your computer.

The Siebel eCollaboration server services, PictureTalk CSS Manager, and 
PictureTalk Meeting Manager are started. The names of the services correspond 
to the Instance Name entered in Step 3. For example, if the instance name is 
ecollab, the services appear as ecollab Meeting Manager and ecollab CSS 
Manager.

Updating the JRun Classpath
Installing the Siebel eCollaboration server updates the class path for the WebSurfer 
in JRun. Each time you reinstall JRun, this class path is lost. If you reinstall JRun 
after installing the eCollaboration server, then you must manually update the JRun 
class path.

To manually update the JRun classpath

1 Choose Start > Programs > Jrun 3.0 > JRun Admin Server.

2 Choose Start > Programs > Jrun 3.0 > JRun Management Console.

The JRun Management Console appears.

3 Choose Jrun Default Server > Java Settings.

4 Check Classpath to confirm the following paths exist.

■ Destination directory/root alias is in the JRun Java class path, where 
destination directory and root alias are values you provided in the 
eCollaboration server installation procedure. Root alias is the virtual 
directory that points to the WebSurfer pages and is typically the default, 
websurfer. For example, an entry here could be D:/eCollaboration/
websurfer.

■ Destination directory/PictureTalk/jsp, for example D:/
eCollaboration/PictureTalk/jsp.

NOTE: JRun classpaths require that you use the forward slash (/) only. The 
backward slash (\) is not interpreted equivalently.
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5 To edit a classpath, drill down on the path name, edit the path, and then click 
Update.

6 Click the JRun Default Server icon in the system tray.

The JRun Default Server dialog box appears.

7 Click Restart to restart the JRun default server.

8 Log out of the JRun Management Console, and stop the JRun Admin Server.

Configuring Network Address Translation 
In an eCollaboration deployment that uses Network Address Translation (NAT), the 
eCollaboration server machine has two different IP addresses—one for client 
machines that are outside the external firewall and one for client machines that are 
either inside the internal firewall or are outside the internal firewall but inside the 
external firewall.

If your implementation uses NAT, you must make the following changes manually 
to the eCollaboration server configuration so that Present and Attend modes 
function properly:

■ Edit the ptkgmgr.ini file to allow the Meeting Manager to communicate the 
proper IP address of the eCollaboration server to clients.

■ Edit the ptklmgr.ini file to allow the HTTP Gateway to connect to the meeting 
using the internal IP address in all cases.

■ Edit the layout_applet_quick file and the framework.template file to allow the 
eCollaboration server to be recognized by the same domain name by all clients, 
independent of the firewall zone they are in. 

You must restart the CSS Manager and Meeting Manager services to activate these 
changes.

A NAT deployment example with the following sample IP addresses is used 
throughout this section. Your IP addresses may vary.

■ 192.168.5.12 is the IP address of the eCollaboration server for client machines 
inside the internal firewall and for client machines outside the internal firewall 
but inside the external firewall.
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■ 206.154.116.227 is the IP address of the eCollaboration server for client 
machines outside the external firewall.

■ IP addresses of all machines that are inside the internal firewall are of the form 
10.35.22.xxx.

■ IP addresses of all machines that are outside the internal firewall but inside the 
external firewall are of the form 192.168.5.xxx.

■ Machines that are outside the external firewall are all other addresses.

Editing the Ptkgmgr.ini File
The ptkgmgr.ini file must contain several netmask and hnetmask entries to allow 
the Meeting Manager to communicate the proper IP address to clients based on the 
clients' network addresses.

To edit the ptkgmgr.ini file 

1 On the eCollaboration server machine, choose Start > Programs > Siebel 
eCollaboration > ecollab Server > Configure Meeting Manager. 

The ptkgmgr.ini file opens in your default text editor. 

2 Add the following lines: 

netmask = 192.168.5.0 255.255.255.0 192.168.5.12

netmask = 10.22.35.0 255.255.255.0 192.168.5.12 

netmask = 0.0.0.0 0.0.0.0 206.154.116.227

These lines specify that machines with IP addresses of 192.168.5.xxx and 
10.22.35.xxx connect to a meeting using IP 192.168.5.12, and all other machines 
connect using IP 206.154.116.227.

3 Add the following lines: 

hnetmask = 192.168.5.0 255.255.255.0 192.168.5.12

hnetmask = 10.22.35.0 255.255.255.0 192.168.5.12 
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hnetmask = 0.0.0.0 0.0.0.0 206.154.116.227

These lines specify the same netmasks as in z XReftep\ Add the following lines: 
for the purpose of connecting clients to the HTTP Gateway, if necessary.

4 Make sure there is a carriage return at the end of the ptkgmgr.ini file, then save 
and close the file.

Editing the Ptklmgr.ini File
The ptklmgr.ini file must contain a line that forces the HTTP Gateway to connect to 
a meeting using the internal IP address for the eCollaboration server, even if the 
client requests the external address.

To edit the ptklmgr.ini file 

1 On the eCollaboration server machine, choose Start > Programs > Siebel 
eCollaboration > ecollab Server > Configure CSS Manager. 

The ptklmgr.ini file opens in your default text editor. 

2 Locate the line that starts with ptkhttpd_opts = and add the following flag at 
the end of the line:

-f<internal_ip_address> 

For example, change the line to:

ptkhttpd_opts = -I192.168.5.12 -p8329 -H192.168.5.12 -P80 -
f192.168.5.12

The parameters in this line represent the following:

■ The -I parameter is the IP address of the HTTP Gateway.

■ The -p parameter is the port of the HTTP Gateway.

■ The -H parameter is the IP address of the Web server.

■ The -P parameter is the port of the Web server.

■ The -f parameter forces the HTTP Gateway to contact the eCollaboration 
server on the IP address that is specified, even though the client may be 
specifying a different address outside the external firewall.
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3 Save and close the file.

Editing the Layout_Applet_Quick File
For Follow-me Web browsing to function, the eCollaboration server must be 
recognized by the same domain name by all clients, independent of the firewall 
zone they are in. 

To edit the layout_applet_quick file 

1 Open the PictureTalk\ptk-apps\java\htdocs.ptk\layout_applet_quick 
file in a text editor.

2 Locate the line that has the following form:

hlines +="'http://<ip_address>:<http_gateway_port>/ptkgw/
ecollab/ptk-apps/java/framewrk' "

3 Replace the IP address with the domain name for the eCollaboration server. For 
example, if the eCollaboration server domain name is www.siebel.com, then 
change

hlines +="'http://192.168.5.12:8329/ptkgw/ecollab/ptk-apps/java/
framewrk' "

to

hlines +="'http://www.siebel.com:8329/ptkgw/ecollab/ptk-apps/
java/framewrk' "

4 Save and close the file.

Editing the Framewrk.template File
For Follow-me Web browsing to function, the eCollaboration server must be 
recognized by the same domain name by all clients, independent of the firewall 
zone they are in. 

To edit the framework.template file

1 Open the PictureTalk\ptk-apps\java\htdocs.ptk\framework.template 
file in a text editor.

2 Locate the line that has the following form:
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hserver_addr=<ip_address>

3 Replace the IP address with the domain name for the eCollaboration server. For 
example, if the eCollaboration server domain name is www.siebel.com, then 
change

hserver_addr=192.168.5.12

to

hserver_addr=www.siebel.com

4 Locate the line that has the following form:

user_icon=http://<ip_address>:<http_gateway_port>/ptkgw/ecollab/
ptk-apps/java/bitmaps/coffeemug.bmp

5 Replace the IP address with the domain name for the eCollaboration server. For 
example, if the eCollaboration server domain name is www.siebel.com, then 
change

user_icon=http://192.168.5.12:8329/ptkgw/ecollab/ptk-apps/java/
bitmaps/coffeemug.bmp

to

user_icon=http://www.siebel.com:8329/ptkgw/ecollab/ptk-apps/
java/bitmaps/coffeemug.bmp

6 Save and close the file.

7 Restart the CSS Manager and Meeting Manager services.

Providing a License Key to the eCollaboration Server
The license.ini file defines for the eCollaboration server the maximum number 
of concurrent users. Siebel Technical Services provides the license.ini file for you to 
use at your site.

To provide the license key to eCollaboration

1 Submit a service request to Siebel Technical Services indicating that you need a 
license.ini file. Provide the following information:
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■ The IP address of the server that hosts the eCollaboration server. The license 
key is based on the server’s IP address. 

NOTE: If you move the eCollaboration server to another machine, you must 
contact Siebel Technical Services to get another license key, or you must 
change the IP address of the new machine to match the IP address with 
which the license key is associated.

■ The number of concurrent users you have licensed.

2 Save the license.ini file to the \PictureTalk\Mgr folder in the eCollaboration 
server root directory. 

Verifying Successful Installation
You can verify a successful eCollaboration installation by confirming that two 
participants can use Follow-me browsing.

To verify successful eCollaboration server installation

1 Choose Start > Programs > Jrun 3.0 > JRun Admin Server to start the JRun 
Admin server.

2 Choose Start > Programs > Jrun 3.0 > JRun Management Console.

The JRun Management Console appears.

3 Choose Jrun Default Server > Java Settings.

4 Check Classpath to confirm the following paths exist. Update the paths, if 
necessary.

■ Destination directory/root alias is in the JRun Java class path, where 
destination directory and root alias are values you provided in the 
eCollaboration server installation procedure. Root alias is the virtual 
directory that points to the WebSurfer pages and is typically the default, 
websurfer. For example, an entry here could be D:/eCollaboration/
websurfer.
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■ Destination directory/PictureTalk/jsp, for example D:/
eCollaboration/PictureTalk/jsp. 

For information about updating the JRun classpath, see “Updating the JRun 
Classpath” on page 49.

5 Open Internet Service Manager.

■ In Windows NT, choose Start > Programs > Windows NT Option Pack 
4.0 > Microsoft Internet Information Server > Internet Service Manager.

■ In Windows 2000, choose Start > Control Panel > Administrative Tools > 
Internet Service Manager.

The Internet Service Manager dialog box appears.

6 Confirm that the virtual directory for WebSurfer is created and points to the right 
directory. It should match the name and path in Step 4. 

7 Start the IIS Admin Service, World Wide Web Publishing Service, JRun Default 
Server, eCollab CSS Manager, and eCollab Meeting Manager services if they are 
not already started.

8 Open a browser and type in http://ecollaboration server domain name/
servlet/CSRLogin?ID=1234, where “1234” can be any number of arbitrary 
digits. The eCollaboration server domain name is the value you entered in the 
Domain field in Step 3 on page 48 (in the procedure “To install the 
eCollaboration server.”) The string servlet/CSRLogin?ID is case-sensitive.

■ To test voice over IP, append &AUDIO=True after the number in the URL to 
activate the voice over IP servlet. 

■ To test the agent’s eCollaboration tool bar, append &ADMIN=True after the 
number in the URL to add the agent's present, attend, and download buttons 
on the cobrowser.

A page with Click Here for next Customer appears.

9 Click the Click Here link.

A new browser opens on a page displaying Please Wait.
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10 Return to the first browser and click the Click Here link again to open another 
browser.

A new browser opens on a page displaying Please Wait. To make viewing easier, 
resize and reposition the two browsers so they are side by side. When you type 
a URL in the address bar of either browser, the other browser should follow to 
the same Web site. 

If verification fails, review the steps of the installation:

■ Verify that you have the correct JRun license.

■ Verify that the JRun Default Server is started, not the Admin Server.

■ Verify that the IIS Admin Service is started on the correct server.

■ Verify that the URL uses the correct cases.

■ Verify that the same CSRLoginID is used in both browsers.

■ You may not be using a valid or open port for either HTTP gateway or JRun. Try 
different ports.

■ Verify that the websurfer directory is mapped to the correct physical directory.

■ Verify that both JRun and the eCollaboration server are running on a different 
machine than the Siebel Web Engine.

Correct any errors or reinstall, if necessary. 
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Setting Server Administration Parameters
You can set parameters in the Server Administration screen to configure the way 
Web collaboration is implemented with Siebel employee application object 
managers, such as those for Siebel Call Center and Siebel Service.

At a minimum, you must set the following parameters to allow Siebel 
eCollaboration to function for a particular Siebel application:

■ For each applicable object manager, set Web Collab Enable Flag to True at the 
component level.

■ Set Web Collab Server to the URL of the server on which eCollaboration is 
installed. Provide this parameter at either the server, server components group, 
or component level.

For information about setting Siebel server parameters, see Siebel Server 
Administration Guide.

Table 2 describes the Siebel eCollaboration server parameters.

Table 2. Siebel eCollaboration Server Parameters 

Parameter Entry

Web Collab Enable (True or False) Set to True to allow Web collaboration for 
this object manager. You must set this parameter to True 
for at least one customer facing application and one 
employee facing application for eCollaboration to work 
correctly.

Web Collab Enable 
Simulation

(True or False) Set to True to bypass Siebel Universal 
Queuing to test Siebel eCollaboration in simulation mode.

Web Collab Language Code 
Map

Specify the name of the language mapping for the Web 
collaboration package that you use. Different vendors have 
different maps. For eCollaboration, the default value is 
PIXION_LANGUAGE_MAP. There is no need to modify this 
value.

Web Collab Log File Provide the full name and path for the log file, or provide 
only the name of the log file to place it in the root log 
directory. The parameter is used only for testing.
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Web Collab Log Level Set the log level to one of the following, depending on the 
way you want application errors to be logged:

0. No log.

1. All error messages are logged.

2. All error messages and warnings are logged.

3. All error messages, warnings, and parameters are 
logged.

4. All error messages, warnings, parameters, and Web 
Collaboration templates are logged. 

Use this parameter only for testing.

Web Collab Package Specify the package of Web Collaboration commands to 
use. By default, Siebel eCollaboration uses the predefined 
package called Siebel eCollaboration. If you define another 
package, the name you enter here must match the name 
you give the package in the Web Collaboration Templates 
view.

Web Collab Server Enter the URL of the server on which eCollaboration is 
installed.   For example, if you installed the eCollaboration 
server on the server that hosts www.siebel.com, you must 
enter http://www.siebel.com.

Web Collab Using Siebel 
Session Id

If you use the Siebel Activity ID as the session handle, as 
is the default for Siebel eCollaboration, enter True; 
otherwise, enter False.

Web Collab Using Siebel UQ If your implementation uses Siebel Universal Queuing, 
enter True; otherwise, enter False.

Table 2. Siebel eCollaboration Server Parameters 

Parameter Entry
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Integrating Web Collaboration into a Communications 
Configuration

Communications configurations contain commands and events that are specific to 
Siebel eCollaboration. Many eCollaboration commands are nested with commands 
that are not specific to eCollaboration to allow eCollaboration to work in the 
multichannel communications toolbar. 

This section describes the high-level tasks you must do and specific guidelines to 
use with those tasks to integrate Siebel eCollaboration with Siebel Communications 
Server and Siebel Universal Queuing. For information about configuring 
communications channels to work with Siebel Communications Server and Siebel 
Universal Queuing, see Siebel Communications Server Administration Guide and 
Siebel Universal Queuing Administration Guide.

To integrate modes of communication with Siebel Communications Server, you 
must create and associate drivers, communications profiles, and communications 
configurations. Following are the tasks in this group that you must perform to 
integrate a Web collaboration application, including Siebel eCollaboration, with 
Siebel Communications Server.

NOTE: You must implement a queuing mechanism to use Siebel eCollaboration. 
Siebel Universal Queuing is one such mechanism.

■ Configure the driver. Define a driver with channel type Web Collaboration and 
specify the DLL file with which the communications server interfaces with the 
Web Collaboration driver. 

■ Configure communications profiles. Define at least one profile for the driver. A 
profile defines the way a driver is used for a particular purpose. If necessary, 
define additional profiles for the driver with parameters to override the default 
parameters. 
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■ Associate profiles with communications configurations. Associate profiles for Web 
collaboration drivers with one or more communications configurations. A 
communications configuration provides a framework to control one or more 
types of incoming, outgoing, or interactive communications. You may have one 
or more communications configurations for different purposes, such as to 
accommodate communications that use a particular kind of CTI middleware or 
to accommodate Web collaboration only. 

■ Modify communications configurations if necessary. Provide commands, command 
data, event handlers, event responses, and event logs related to Web 
collaboration in configurations, if necessary.

NOTE: Your Siebel application provides seed configurations that support voice, 
email, and Web collaboration channels. You can modify their commands and event 
handlers. You should use only the seed configurations or ones derived from them.

To remove the Web Collaboration channel from the configuration, you need to 
remove the LoginToWebCollab and LogoutFromWebCollab commands from the   
configuration.

Setting Up a Siebel Universal Queuing Configuration for Web 
Collaboration

You must do the following high-level tasks to set up a Universal Queuing (UQ) 
configuration for Web collaboration. 

NOTE: For specific information about setting up UQ configurations, see Siebel 
Universal Queuing Administration Guide.

■ Create a UQ configuration and designate it as the primary configuration.

■ Create a channel of type Web Collaboration and add at least one property, 
SiebelChannelType, to the channel.

■ Create a route of type Web Collaboration and add at least one property with the 
following field values and one escalation rule:

■ Property Name: SiebelChannelType

■ Relation: ~ 
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■ Property value: Web*

■ Assign employees (agents) to the Web collaboration channel you create.

Setting Up a Communications Configuration for Web Collaboration
You must do the following high-level tasks to set up a communications 
configuration for Web collaboration. 

NOTE: For specific information about setting up communications configurations, see 
Siebel Communications Server Administration Guide.

■ Create a communications configuration.

■ Create a driver of type Web Collaboration or use the default library 
sscmimed.dll.

■ Create a profile for the driver and override the driver parameters if necessary.

■ Add the profile to the configuration.

■ Specify the name of the UQ configuration as a parameter of the communications 
configuration.

■ Assign agents to the communications configuration. 

Default Communications Configurations Related to Web 
Collaboration
Communications configuration commands and event handlers are configurable. 
You are provided the following default commands and event handlers for Web 
collaboration as part of your Siebel applications installation.
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Setting Up Agents to Receive Web Calls
To allow an agent to receive Web call requests, you must perform the following 
tasks. 

■ Associate agents with communications configurations that support the Web 
Collaboration channel. An agent must be associated with an active 
communications configuration to receive any type of communication. For the 
agent to receive Web calls, the configuration must include a profile for a Web 
collaboration driver.

■ Associate agents with telesets and extensions. Telephone calls must be routed to 
hardware used by the agent. 

■ Define the agent in Universal Queuing. Each agent’s skills are associated with the 
communications configuration, and they are defined under UQ. Universal 
Queuing routes calls and service requests from callers to agents based on agents’ 
skills.

■ Set up routing rules in Universal Queuing. You can create business rules to 
determine the agents to whom Web collaboration requests with different 
attributes are routed.

For more specific information about associating agents with communications 
configurations, telesets, and extensions, see Siebel Communications Server 
Administration Guide. 

For more specific information about defining agents in Siebel Universal Queuing, 
see Siebel Universal Queuing Administration Guide.

Use the following Web collaboration-specific guidelines when you perform these 
association tasks.

■ Define at least one route of channel type Web Collaboration with property 
SiebelChannelType ~ Web*.

■ Specify the number of simultaneous sessions of channel type Web Collaboration 
for the agent to be at least 1.
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To associate an agent with a communications configuration

1 Choose View > Site Map > Communications Administration > All 
Configurations.

2 Pick the configuration that comprises the current set of drivers you are 
implementing.

3 Click the Agents view-level tab.

4 In the Agents list, add a new record.

5 Pick one or more users to associate as agents with this communication 
configuration.

6 Click the Parameters view-level tab.

7 In the Parameters list, add a new record.

8 Complete the record, and then click Save. Use the following guidelines.

You must also associate an agent with a Siebel Universal Queuing configuration.

Field Description

Name Required. Enter UQConfigurationName. This field is case 
sensitive.

Value Required. Enter the name of the primary Universal Queuing 
configuration, as specified in the UQ Administration screen.

Active Check this field to associate the UQ configuration with the 
selected communication configuration. 
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To associate an agent with a UQ configuration

1 Choose View > Site Map > UQ Administration > Configurations.

2 Select the primary configuration. 

3 From the Show drop-down list, choose Employees.

4 Select one of the employees you picked in “To associate an agent with a 
communications configuration.”

5 In Skills, list any skills. In the Employee Competencies list, enter the associated 
competencies and skill levels.

6 From the Show drop-down list, choose Channels.

7 Choose a channel of type Web Collaboration.

8 From the Show drop-down list, choose Routes.

9 Select a route or add a new route record.

10 Create a property for the route.

11 In the Escalations list, add a new record and name it. Enter a time out value, the 
interval at which UQ puts the item back in the queue if it is not picked up.

12 In the Escalations Rules list, define the parameters for the escalation, such as 
routing this to an agent with a specific expertise.

NOTE: An agent cannot control telephone calls with the communications toolbar if 
CTI middleware is not installed. However, the agent can manually dial a user’s 
telephone number to make a call back. The Call Back and Call Back & Collaboration 
options are displayed to callers unless you deactivate their display. In the 
WEB_COLLAB_TYPE list of values, uncheck the Active field in the records with 
Display Value Call Back and Call Back & Collaboration to remove them from the 
picklist displayed to callers in the Live Web Assistance form.
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This chapter provides information for balancing Web collaboration loads on 
multiple eCollaboration servers. This strategy allows you to use different 
eCollaboration servers for different Siebel customer applications through which 
callers request Web collaboration sessions.

When an agent accepts a Web collaboration session, the agent is joined to the 
session to which the customer is already joined. The agent is joined to the correct 
session because the work item associated with the session contains the session ID 
and the domain name of the eCollaboration server on which the session exists. 

The work item determines the eCollaboration server to which the caller is 
connected from the Web Collab Server parameter of the object manager from which 
the collaboration session is requested. In a configuration in which load-balancing is 
not implemented, the Web Collab Server parameter is usually set at the server level. 

For load balancing, you must set the Web Collab Server parameter at the component 
level for the object manager for each customer application that implements Web 
collaboration. Set each object manager to a specific eCollaboration server, so that 
different object managers on the same Siebel Server can connect to different 
eCollaboration servers. For example, you can set the eServiceObjMgr component to 
use one eCollaboration server and the eSalesObjMgr component to use another 
server. You can also specify that multiple object managers use the same 
eCollaboration server. 

NOTE: To simplify management of multiple eCollaboration servers, you may want to 
define all of the server parameters related to eCollaboration at the component level. 
If you define a parameter at the component level, you should remove it at the server 
level because a server level setting can override a component level setting.
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In addition, you must also set the Web Collab Server parameter for the Siebel 
employee application object manager, such as CallCenterObjMgr. Then on an 
agent’s initial login to Siebel Universal Queuing on a particular computer, the agent 
is able to receive a download of client software from the eCollaboration server 
specified in the parameter. 

For information about setting server parameters for Siebel eCollaboration, see 
“Setting Server Administration Parameters” on page 2-20.

For information about setting Siebel Server parameters in general, see Siebel Server 
Administration Guide.
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Configuring the Siebel eCollaboration Server
After installing and setting up the eCollaboration server, you may need to change 
some of the properties that are defined in the server’s config.properties file. 

The config.properties file is located in the \eCollaboration\websurfer directory on 
each eCollaboration server. To modify an eCollaboration server’s properties, edit the 
config.properties file in a text editor. 

You can change the following properties:

■ DomainName. This property defines the domain name of the eCollaboration 
server. If you have changed the domain of the eCollaboration server, you must 
change this property value.

■ DefaultURL. This property lets you pick the initial URL that is displayed in the 
cobrowser's browsing area prior to loading the last page the caller was on. For 
faster network bandwidths, this page appears for microseconds and is never 
seen by either the caller or the agent. On slower networks, this page appears for 
a few seconds. The page appears based on network bandwidths, and not 
necessarily the speed at which the caller or agent is connected to the network. 

■ Proxyset, proxyhost, and proxyport. Set these properties if you implement a proxy 
server configuration.

■ RecordURLs. This property allows you to toggle listing the URLs in a chat.

■ TruncateURLlen. Use this property to limit the number of characters for a URL in 
the chat. Set the property to TRUE to truncate the URL and set the 
TruncateURLlen to the number of characters that you want to be shown. If a URL 
is longer than the maximum length, it will be appended with ellipses. When you 
set the property to FALSE, TruncateURLlen is ignored.

NOTE: You should not change other properties in the config.properties file that are 
not listed here.
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Siebel eCollaboration Server Performance Tuning
This section provides suggestions for tuning the eCollaboration server to improve 
its performance and response time. However, you do not have to modify the server. 

Tuning the eCollaboration server requires that you perform the following tasks: 

■ Modify Microsoft Internet Information Service (IIS) Server settings

■ Modify Macromedia JRun settings

Modifying Microsoft Internet Information Service Server Settings
You must modify several IIS properties on the eCollaboration server.

To modify Microsoft IIS Server settings

1 Right click on My Computer, and then select Properties.

2 Click the Advanced tab, and then click Performance Options.

NOTE: Set Application response to Background services.

3 From the Start menu, choose Programs > Administrative Tools > Internet 
Services Manager.

4 Right click on Default Web Site (your Web server), and then select Properties. 
Make sure that the following parameters have the values shown.

5 Restart the Web server.

Parameter Value

Connections unlimited

HTTP Keep-Alives enabled (checked)

Enable Logging disabled (unchecked)
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Modifying Macromedia JRun Settings
Macromedia JRun 3.1 or later allows you to make the performance tuning settings 
that are described in this section.

You can download and install JRun 3.1 or later from Macromedia’s Web site at 
http://macromedia.com. You can use the same license key that you are provided 
with JRun 3.0.2 on the Siebel Windows Server Ancillary Programs CD-ROM. To 
complete the JRun 3.1 or later installation, perform the steps described in 
“Configuring JRun” on page 2-10.

After you complete the initial configuration, you must modify several JRun settings 
on the eCollaboration server.

To modify JRun 3.1 settings

1 From the Start menu, choose Programs >JRun 3.1 > JRun Admin Server to start 
the JRun Admin server.

2 From the Start menu, choose Programs > JRun 3.1 > JRun Management 
Console. 

3 Log in as admin.

4 Choose JRun Default Server > Java Settings.

5 Make sure that the Java Executable path correctly defines the path to the 
javaw.exe.

6 Click on Java Arguments, change the settings to -server -Xmx512M -Xms128M, 
and then click update.

7 Choose JRun Default Server > External Web Server. Make sure that the 
following parameters have the values shown. Click update after making each 
change.

Parameter Value Comment

Minimum Thread Count 300 Typically, you should set this to twice the average 
number of concurrent sessions on this server.
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8 Choose JRun Default Server > Log File Settings. Make sure that the following 
parameters have the values shown.

9 Restart the JRun Default Server.

Maximum Active Requests 500

Maximum Concurrent Requests 2,000

Parameter Value Comment

Parameter Value

Info disabled (unchecked)

Warning disabled (unchecked)

Error enabled (checked)
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You can configure Siebel eCollaboration in the following ways:

■ “Configuring Siebel eCollaboration Views” on page 74

■ “Configuring Lists of Values Used with Web Collaboration” on page 76

■ “Configuring Sound on the Communications Toolbar for eCollaboration” on 
page 78

Screens are provided for you to administer Siebel eCollaboration in the following 
ways:

■ “Working with Web Collaboration Templates” on page 79. You can add, delete, 
or modify templates used in communications configurations for Web 
collaboration. 

■ “Checking the Status of a Session” on page 80. You can check the status of active 
and completed sessions.

■ “Viewing the Text of a Siebel eCollaboration Chat” on page 81. You can view the 
text of a session’s chat.
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Configuring Siebel eCollaboration Views
This section describes specific guidelines you must use if you configure the views 
used with eCollaboration. For specific information about configuring views and 
applets, see Siebel Tools Reference.

Web Collab All Activities View
The Web Collab All Activities view is the view in which an agent uses Siebel 
eCollaboration. The Web Collab All Activities view is based on the Action business 
object and the Action business component. 

You can configure the Web Collab All Activities view to display or hide any of the 
fields in the Action business component. You can also change the fields’ locations 
and display labels.

If you configure the Web Collab All Activities view, follow these specific guidelines:

■ If you specify PiggybackScriptTemplate for the communications event response 
[EventResponse:WebCollabWorkStarted], one and only one of the applets in the 
view must be based on the CSSSWEFrameCallMe class.

■ The default activity list applet in the Web Collab All Activities view is Web 
Collab User Activity List Applet which is based on the Action business 
component and the CSSSWEFrameListCallMe class. The records in the list applet 
are queried by Primary Contact Id and sorted by Created in descending order.

Web Collab Request Form View
The Web Collab Request Form view is the view in which a caller requests a Web 
collaboration session.

If you configure the Web Collab Request Form view, follow this specific guideline:

■ The applet that contains the Submit and Cancel buttons must be based on the 
CSSSWEFrameCallMe class.

Web Collab Acknowledging View
The Web Collab Acknowledging view contains the thank you message displayed to 
the caller after the caller submits a request for a collaboration session. If you 
configure the Web Collab Acknowledging view, follow this specific guideline:
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■ One and only one of the applets in the view must be based on the 
CSSSWEFrameCallMe class.
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Configuring Lists of Values Used with Web Collaboration
You can modify lists of values in the Applications Administration screen of Siebel 
employee applications.

For information about modifying lists of values, see Siebel Tools Reference.

The following lists of values are associated with Web collaboration:

■ WEB_COLLAB_PACKAGE. Defines the list of Web collaboration packages.

■ WEB_COLLAB_TYPE. Defines the Web Collaboration subtypes; that is, Call Types 
and Contact Methods that are supported.

■ WEB_COLLAB_TOOLBAR_DESP_TMPL. Defines the template for generating the 
brief description of the Web collaboration work item on the toolbar. You can use 
the %1 variable to obtain the caller's name defined by the WebCollab User 
Name - Toolbar field of the User business component. You can use the %2 
variable to obtain the current Web Collaboration subtype.

The following examples illustrate usage of the variables:

WEB_COLLAB_TOOLBAR_DESP_TMPL Web Collaboration with %1

WebCollab User Name - Toolbar [Full Name]

(evaluates to John Doe)

Current contact method Chat & Collaboration

Result displayed as description of Web 
collaboration work item

Web Collaboration with John Doe

WEB_COLLAB_TOOLBAR_DESP_TMPL ‘%2' from %1

WebCollab User Name - Toolbar [First Name]

(evaluates to John)

Current contact method Chat & Collaboration

Result displayed as description of Web 
collaboration work item

‘Chat & Collaboration’ from John
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■ WEB_COLLAB_AGENT_NAME_TMPL. Defines the template for generating the 
agent’s name as it appears in the chat box. You can use the %1 variable to obtain 
the agent’s name defined by the WebCollab User Name - Chatbox field of the 
User business component.

The following example illustrates usage of the variable:

■ WEB_COLLAB_CALLER_NAME_TMPL. Defines the template for generating the 
caller’s name as it appears in the chat box. You can use the %1 variable to obtain 
the caller’s name defined by the WebCollab User Name - Chatbox field of the 
User business component.

The following example illustrates usage of the variable:

WEB_COLLAB_AGENT_NAME_TMPL Agent %1

WebCollab User Name - Chatbox [First Name]

(evaluates to John)

Result displayed as agent’s name Agent John

WEB_COLLAB_CALLER_NAME_TMPL Customer %1

WebCollab User Name - Chatbox [Full Name]

(evaluates to John Doe)

Result displayed as caller’s name Customer John Doe
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Configuring Sound on the Communications Toolbar for 
eCollaboration

You can configure the sound that accompanies a blinking accept work button on the 
communications toolbar. 

For information about configuring the communications toolbar, see Siebel 
Communications Server Administration Guide.
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Working with Web Collaboration Templates
The templates provided as seed data in the Web Collaboration Templates view 
provide vendor-specific URLs and scripts that are used by Siebel applications to 
communicate with the vendor’s Web collaboration server.

For collaboration technologies by vendors other than Siebel Systems, you must 
modify the communications configuration related to Web collaboration, if 
necessary, and add all the templates you use. If you plan to implement and switch 
between different technologies, you can define a set of templates, or package, for 
each vendor and switch between the packages.

You can access the Web collaboration templates by logging into a Siebel employee 
application and choosing View > Site Map > Communications Administration > 
Web Collaboration Templates.

Following are the templates provided as seed data for the default Siebel 
eCollaboration implementation. 

■ AgentLoginScript. This JavaScript updates and installs plug-ins for voice over IP 
and presentation on the agent’s Windows desktop when the agent logs in to the 
Web collaboration server.

■ AgentJoinScript. This JavaScript downloads and starts the agent-side applets 
when the agent joins a session.

■ AgentJoinURL. This URL notifies the Web collaboration server when the agent 
joins a session.

■ AgentReleaseURL. This URL notifies the Web collaboration server when the agent 
ends a session from the communications toolbar.

■ AgentTransferURL. This URL notifies the Web collaboration server when the agent 
does a blind session transfer from the communications toolbar.

■ CallerSubmitScript. This JavaScript submits a session request to the Web 
collaboration server and downloads and starts caller-side applets.
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Checking the Status of a Session
An activity is created for each Web collaboration session. The caller is the primary 
contact of the activity and the agent who accepts the call is the primary owner. You 
can check the status of a Web collaboration session. The status can have one of the 
following values:

■ Requested. The caller has requested the session, but the agent has not yet joined.

■ Cancelled. Before the agent joins the session, the caller closes the pop-up 
window that the caller has been cautioned to not close or the meeting will be 
cancelled.

■ In progress. Both the agent and the caller are logged in to the session.

■ Done. The session is terminated.

To check the status of a Web collaboration session

1 Choose View > Site Map > Communications.

2 From the Show drop-down list, choose My Web Collaboration Activities or All 
Web Collaboration Activities, if it is available.

The Web Collaboration Activities list appears.

3 In the Web Collaboration Activities list, navigate to an activity record.

The record provides statistics for the session, including its status.
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Viewing the Text of a Siebel eCollaboration Chat 
At the end of a Siebel eCollaboration session or when the session is transferred, the 
text of its Web chat is saved automatically as an attachment to the activity for the 
session. If a collaboration session is transferred from the original agent to one or 
more other agents, a separate chat attachment is saved for each agent’s segment of 
the session.

To view the text of a session’s chat

1 Choose View > Site Map > Communications.

2 From the Show drop-down list, choose My Web Collaboration Activities or All 
Web Collaboration Activities, if it is available.

The Web Collaboration Activities list appears.

3 In the Web Collaboration Activities list, select an activity record.

4 Click the Chat Scripts view-level tab.

The Chat Scripts list appears. 

5 Click the hyperlink for the chat. 

A text file containing the chat’s text opens in the editor that is associated with 
the .txt extension.
Version 7.5, Rev. A Siebel eCollaboration Administration Guide 81



Configuring and Administering Siebel eCollaboration

Viewing the Text of a Siebel eCollaboration Chat
82 Siebel eCollaboration Administration Guide Version 7.5, Rev. A



Index
A
agent client, about using 38
AgentJoinScript template, about 79
AgentJoinURL template, about 79
AgentLoginScript template, about 79
AgentReleaseURL template, about 79
agents

See also Web call requests
blind transfer, performing 30
callers desktop, allowing to view 21
chatting, about typing chat message 31
consultative transfer using chat or voice 

over IP session, performing 31
consultative transfer using telephone, 

performing 30
dynamic joint Web form filling, 

about 26
dynamic joint Web form filling, 

principles 26
eCollaboration experience, about 24
eCollaboration overview 13
eCollaboration session request, 

accepting 25
eCollaboration session, ending 33
features available to 14
Follow-me browsing, about 26
mouse point icon, changing 29
Present and Attend modes, about 27
Present and Attend modes, turning on 

mouse pointer 27
Present and Attend modes, using 

(procedure) 27
session transfers, about and type of 29
telephone calls, about controlling 65

toolbar buttons, provided to agent and 
caller 15

toolbar buttons, provided to agent 
only 15

voice over IP session, about using 31
voice over IP session, changing audio 

settings 32
voice over IP session, terminating 32
volume levels, changing 32
volume levels, controlling 32

AgentTransferURL template, about 79
architecture overview

components, list of 34
ending session, process of 37
presentation session, about invoking by 

agent 36
Web collaboration session, process of 

joining agent to session 35
Web collaboration session, process of 

joining caller to session 34
attachments, restrictions regarding 20
audience for guide 7
audio settings

agent, changing by 32
end user, changing by 22
volume levels, controlling by agent 32
volume levels, controlling by end 

user 23

B
blind transfer

about 29
performing (procedure) 30

browser
 See also Follow-me browsing
Version 7.5, Rev. A Siebel eCollaboration Administration Guide 83



cobrowser, caution when closing 21

C
Call Back & Collaboration session, 

described 18
Call Back session, described 18
call-back, about listing as required 25
caller agent, about using 38
callers

desktop visibility, controlling 29
desktop, allowing agent to view 21
eCollaboration overview 13
eCollaboration session, requesting 18
meeting, requesting virtual meeting 17
toolbar buttons, provided to 15

CallerSubmitScript template, about 79
Cancelled session status value, about 80
capture frame appears, about 28
chat

chat message, about availability and 
typing message 31

chat mode, about 22
consultative transfer, perform a transfer 

using 31
transcript, about saving 33

Chat & Collaboration session, 
described 18

Chat Only session
described 18
ending 23

cobrowser, caution when closing 21
communications configuration

See also Web collaboration
agent, associating with 64

communications profiles, about configuring 
Web Collaboration 60

communications toolbar, about configuring 
sound 78

consultative transfer
about 29
chat or voice over IP session, performing 

using 31
telephone, using 30

D
desktop

See also Present and Attend modes
callers desktop, allowing agent to 

view 21
Done session status value, about 80
driver, about defining for Web 

Collaboration 60
dynamic joint Web form filling

See Web form

E
eCollaboration

See Siebel eCollaboration
eCollaboration session

agent, ending by 33
eCollaboration session request, 

accepting 25
end user, ending by 23
requesting by caller 18

end user
voice over IP session, ending 23
volume levels, controlling 23

F
firewall settings, configuring 39
Follow-me browsing

about 12
agent, using by 26
caller’s window (diagram) 19
joint Web form filling out 20
pausing and resuming 19

G
guide

audience for 7
organization of 8

I
implementation

components of 39
setup overview 40
84 Siebel eCollaboration Administration Guide Version 7.5, Rev. A



In progress session status value, about 80
installation, server

install verification fails 57
install, verifying success 55
installing, about and procedure 46
license key, providing 54
Macromedia (Allaire) JRun, installing and 

configuring 42
overview 42
requirements 41

J
Javascript, restrictions on form filling 20
joint Web form filling

about filling out jointly and 
principles 20

agent, principles 26
agent, using by 26
Javascript, restrictions on 20

JRun
installing 43
JRun classpath, manually updating 49
JRun Management Console, using to 

configure JRUN 45
overview 42

L
license key, providing for Siebel 

eCollaboration server 54
licenses needed for installation 41
List of Values, associated with Web 

Collaboration 76

M
Macromedia (Allaire) JRun

See JRun
meeting, requesting virtual meeting 17
microphone, toggling 22
Moderator Request Received dialog box, 

about using 21
mouse pointer

icon, changing 29

turning on 27

O
organization of guide 8

P
parameters

See Server Administration parameters, 
setting

Pixion’s PictureTalk server, and installing 
Siebel Collaboration server 47

Present and Attend modes
See also Present mode
agents, about using 27
desktop presented by agent 21
mouse point icon, changing 29
mouse pointer, turning on 27
using (procedure) 27

Present mode
See also Present and Attend modes
downloading software 24
plug-in, about offering download 21

presentation session, meeting and voice 
over IP session meetings 36

profiles, about associating with 
communications configurations 61

R
Requested session status value, about 80
requirements

components for server setup 39
installation and licensing before 

installation 41

S
seed configurations, about modifying for 

Web Collaboration 61
Server Administration parameters, setting

about and screen diagram 58
minimum parameters, about setting 58
parameters (table) 58

server installation
Version 7.5, Rev. A Siebel eCollaboration Administration Guide 85



install verification fails 57
installing, about and procedure 46
license key, providing 54
Macromedia (Allaire) JRun, installing and 

configuring 42
overview 42
requirements 41
verifying successful installation 55

session
checking status (procedure) 80
session’s chat, viewing text of 81
status values, list of 80

session transfers
about and types of 29
blind transfer, performing 30
consultative transfer using telephone 30

session, eCollaboration
See eCollaboration session

session, Web collaboration
See Web collaboration

Siebel eCollaboration
See also individual Siebel eCollaboration 

entries
components of and location 39
end user overview 13
setting up process 40

Siebel eCollaboration client
See also individual Siebel eCollaboration 

entries
about 38
caller agent 38
Web collaboration agent, about using 38

Siebel eCollaboration server
See also individual Siebel eCollaboration 

entries
install verification fails 57
installation, verifying successful 55
installing (procedure) 47
installing, about and pretasks 46
JRun classpath, manually updating 49
license key, providing 54
note, about moving to another 

machine 55

Siebel eCollaboration, administering
See also individual Siebel eCollaboration 

entries
session status, checking 80
session’s chat, viewing text of 81
Web Collaboration templates, list of 79
Web Collaboration templates, working 

with 79
Siebel eCollaboration, configuring

See also individual Siebel eCollaboration 
entries

List of Values, configuring used with Web 
Collaboration 76

sound, about configuring on 
communications toolbar 78

Web Collab Acknowledging view, about 
and configuration guidelines 74

Web Collab All Activities view 74
Web Collab Request Form view, about 

and guidelines 74
Siebel Universal Queuing

agent, associating with 65
eCollaboration, about use in 24
Web Collaboration, setting up for 61

sound, about configuring on the 
communications toolbar 78

T
telephone

telephone calls, agent control of 65
telephone communication, using for 

consultative transfer 30
templates

Web Collaboration templates, list of 79
Web Collaboration templates, working 

with 79
toolbar

about and figure 15
buttons described 15
sound, about configuring sound on 78

transcript, chat, about saving 33
transferring sessions

 See session transfers
86 Siebel eCollaboration Administration Guide Version 7.5, Rev. A



U
Universal Queuing

See Siebel Universal Queuing

V
virtual meeting, requesting 17
voice over IP & Collaboration session, 

described 18
voice over IP session

about using 22
agent, terminating by 32
agent, used by 31
audio settings, changing by agent 32
audio settings, changing by end user 22
consultative transfer, performing a 

transfer using 31
end user, terminating by 23
and presentation session 36
requirements for 18
volume levels, controlling 23
volume levels, controlling by agent 32

volume levels
agent, controlling by 32
end user, controlling by 23

W
Web call requests

See also agents
agents, setup tasks 63
communications configuration, 

associating an agent with 64
guidelines 63
UQ configuration, associating agent 

with 65
Web Chat, about 22
Web Collab Acknowledging view, about and 

configuration guidelines 74
Web Collab All Activities view, about and 

guidelines 74
Web Collab Request Form view, about and 

configuration guidelines 74
Web collaboration

See also Web collaboration, integrating 
into communications

communications configuration, 
integrating into 60

eCollaboration session, requesting 18
List of Values, configuring 76
session options, list of 18
session status, checking 80
session, about 12
session’s chat, viewing text of 81
technologies, functionality with 24
templates, list of 79
templates, working with 79
Web Collaboration channel, about 

removing from configuration 61
Web collaboration agent, about using 38
Web Collaboration channel, about removing 

from configuration 61
Web collaboration, integrating into 

communications
See also Web collaboration
communications commands and event 

handlers (table) 62
communications configuration, setting up 

for 62
integration tasks (list of) 60
Siebel Universal Queuing, setting up 61

Web form
filling out jointly 20
Javascript, restrictions on 20
joint Web form filling, list of 

principles 26
joint Web form filling, used by agents 26
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